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Disclaimer

1.1 AVEVA does not warrant that the use of the AVEVA software will be uninterrupted, error-free or free from viruses.

AVEVA shall not be liable for: loss of profits; loss of business; depletion of goodwill and/or similar losses; loss of
anticipated savings; loss of goods; loss of contract; loss of use; loss or corruption of data or information; any special,
indirect, consequential or pure economic loss, costs, damages, charges or expenses which may be suffered by the
user, including any loss suffered by the user resulting from the inaccuracy or invalidity of any data created by the
AVEVA software, irrespective of whether such losses are suffered directly or indirectly, or arise in contract, tort
(including negligence) or otherwise.

1.2

1.3 AVEVA's total liability in contract, tort (including negligence), or otherwise, arising in connection with the
performance of the AVEVA software shall be limited to 100% of the licence fees paid in the year in which the user's
claim is brought.

1.4 Clauses 1.1 to 1.3 shall apply to the fullest extent permissible at law.

In the event of any conflict between the above clauses and the analogous clauses in the software licence under
which the AVEVA software was purchased, the clauses in the software licence shall take precedence.

1.5

Copyright

Copyright and all other intellectual property rights in this manual and the associated software, and every part of it
(including source code, object code, any data contained in it, the manual and any other documentation supplied
with it) belongs to, or is validly licensed by, AVEVA Solutions Limited or its subsidiaries.

All rights are reserved to AVEVA Solutions Limited and its subsidiaries. The information contained in this document is
commercially sensitive, and shall not be copied, reproduced, stored in a retrieval system, or transmitted without the
prior written permission of AVEVA Solutions Limited. Where such permission is granted, it expressly requires that
this copyright notice, and the above disclaimer, is prominently displayed at the beginning of every copy that is made.

The manual and associated documentation may not be adapted, reproduced, or copied, in any material or electronic
form, without the prior written permission of AVEVA Solutions Limited. The user may not reverse engineer,
decompile, copy, or adapt the software. Neither the whole, nor part of the software described in this publication
may be incorporated into any third-party software, product, machine, or system without the prior written
permission of AVEVA Solutions Limited, save as permitted by law. Any such unauthorised action is strictly prohibited,
and may give rise to civil liabilities and criminal prosecution.

The AVEVA software described in this guide is to be installed and operated strictly in accordance with the terms and
conditions of the respective software licences, and in accordance with the relevant User Documentation.
Unauthorised or unlicensed use of the software is strictly prohibited.

Copyright 2003 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved. AVEVA shall not be
liable for any breach or infringement of a third party's intellectual property rights where such breach results from a
user's modification of the AVEVA software or associated documentation.

AVEVA Solutions Limited, High Cross, Madingley Road, Cambridge, CB3 0HB, United Kingdom.

Trademarks

AVEVA and Tribon are registered trademarks of AVEVA Solutions Limited or its subsidiaries.  Unauthorised use of the
AVEVA or Tribon trademarks is strictly forbidden.

AVEVA product/software names are trademarks or registered trademarks of AVEVA Solutions Limited or its
subsidiaries, registered in the UK, Europe and other countries (worldwide).

The copyright, trademark rights, or other intellectual property rights in any other product or software, its name or
logo belongs to its respective owner.
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CHAPTER 1 - Preface

LFM Server Autodesk AutoCAD Help Guide

Preface1

This chapter gives basic information about this guide, training and support.

About this Guide1.1

This guide describes how to link the AutoCAD interface to AVEVA LFM Server.

Audience1.2

This set of documentation is aimed at new users and covers the use of AVEVA

LFM Server: Server Mode, its associated AutoCAD link and production of AVEVA

LFM related resources such as HyperBubble data, Solid Point Cloud data and

AVEVA LFM NetView projects. The contents covers operations for both

Engineering Users and Project Administrators. It is assumed that the user already

has AVEVA LFM Server installed and has the appropriate license features

available.
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Related Documents1.3

Other related documents include:

· AVEVA LFM Server – Autodesk Navisworks Interface 

· AVEVA LFM Server – Autodesk Revit Interface 

· AVEVA LFM Server - Aveva PDMS CAD Interface 

· AVEVA LFM Server - Aveva Review CAD Interface 

· AVEVA LFM Server - Bentley MicroStation CAD Interface 

Also covers Bentley ConstructSim

· AVEVA LFM Server - Intergraph PDS CAD Interface 

· AVEVA LFM Server - Intergraph SmartPlant 3D CAD Interface 

· AVEVA LFM Server - Intergraph SmartPlant Review CAD Interface 

· AVEVA LFM Server - COMOS Walkinside CAD Interface 

· AVEVA LFM Server - Quick Start Guide 

The AVEVA LFM Server Quick Start Guide is not intended to cover every

aspect of this package, but should provide designers with a 3D CAD

background a quick introduction to common features and typical project

requirements.

· AVEVA LFM NetView Project Publishing Guide 

This guide covers the creation and deployment of an AVEVA LFM NetView

project from the point that the AVEVA LFM Server dataset (.lfd) is

available up until, and including the point where the VHD is created.

· HyperBubble and Solid Point Cloud Creation and Use Guide 

This guide covers everything related to the new HyperBubble feature

including pre-requisites, publishing and use.

Note: These documents can be accessed by opening the file browser and

browsing to the location where AVEVA LFM Server is installed. By default, they

are available at the following location:

C:\Program Files\LFM Software\LFM\helpfiles
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Technical Support1.4

Online support and more information about AVEVA LFM should be requested

through lfm.support@aveva.com.

To aid fault diagnosis, please include the following information when contacting

AVEVA LFM Support:

· Urgency

· Full version number of AVEVA LFM Server

· Information about any CAD package being connected to (including full

version number)

· AVEVA LFM Server log files. To obtain these, go to the File > Home tab

and click the Copy Log Files button. This copies a series of 5 text files to

the location of your choice. These will be called lfmServerRunA.log –

lfmServerRunE.log. Please send all 5 files.

AVEVA LFM Upgrades

Upgrades can be downloaded from the AVEVA LFM Software website from

https://www.aveva.com/en/Services_and_Support/AVEVA_Product_Support/#LFM

-Support.

Product and Training Information1.5

For general information and commercial enquiries, please contact

lfm.info@aveva.com.

For information about product training courses, see the Product Training section of

AVEVA's website (http://www.aveva.com/training), or contact the nearest AVEVA

Regional Support Centre (http://support.aveva.com/support).

https://www.aveva.com/en/Services_and_Support/AVEVA_Product_Support/#LFM-Support
https://www.aveva.com/en/Services_and_Support/AVEVA_Product_Support/#LFM-Support
http://www.aveva.com/training
http://support.aveva.com/support
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AutoCAD Link Overview2

Data points can be viewed directly within AutoCAD. In operation, AVEVA LFM

Server and AutoCAD work side by side. All of the existing AVEVA LFM Server

functionality is still accessible, but at any time, by opening up AutoCAD, the user

can view points through their familiar AutoCAD environment. AVEVA LFM Server

works as a points server to AutoCAD providing new views dynamically as the user

flies around.

After the AutoCAD Link is established, points visible within AVEVA LFM Server will

also be displayed in each of the AutoCAD views. Each of the AutoCAD views can

be zoomed and panned as normal. AVEVA LFM Server will detect each of these

movements and place its own views to match. Normally, the low-density display

will be shown initially, and any selected volumes at high density. The low-density

display can be turned off to show just the selected volumes.
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Starting the AutoCAD Link3

This section provides details on AutoCAD licence feature, supported versions and

setting up a communication link to AVEVA LFM Server.

Verifying Licence feature3.1

Before you start the AutoCAD link, ensure that you have a licence to use this

feature.

To check if you have a valid licence:

· Run AVEVA LFM Server and select File > Licences. AutoCAD will be

listed under the Licence feature name section if a licence is available.

Note:  If AutoCAD is not listed in the AVEVA LFM Server options then the

AutoCAD link licence is not valid. For information regarding licence update,

contact lfm.license@aveva.com.

Supported versions3.2

AutoCAD support exists for 2014-2020 (including x64 versions).
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Loading the AVEVA LFM Server ARX3.3

The ARX files are a part of the AVEVA LFM installation and are located at the

following path:

\Program Files\LFM Software\LFM\arx

Note:  Before you attempt to start the link, ensure that AVEVA LFM Server is
running and a dataset is loaded.

To load the AVEVA LFM Server ARX:

1. Within the AutoCAD command window, type appload to open the

browser window.

2. Select the appropriate .arx file, for example, lfmServer2017.arx for

AutoCAD 2017. After the arx application is loaded, the AVEVA LFM tool

palette appears in the AutoCAD window.

3. To initiate communication between AutoCAD and AVEVA LFM Server,

click the icon below:

The points are displayed in the relative viewpoints in AutoCAD in low

density unless you select a pre-selected volume. 

4. Click the icon again to suspend the link until the function is re-selected.

To check if AutoCAD is connected to AVEVA LFM Server, refer to the AVEVA

LFM Server header bar as demonstrated below:
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After the link starts, any screen updates will also have points overlaid, unless

points display is turned off.

Recommended display settings3.4

To allow optimal point cloud viewing and volume selection within the AutoCAD

environment, it is recommended that the drawing viewports are set as shown

below:

The AutoCAD menu bar options are as shown below:

View > Viewports > New Viewports > Three: Right (Setup - 3D).

The AVEVA LFM Server link to AutoCAD supports all available visual styles.

2D Wireframe has graphical limitations when working with laser point clouds, but

can offer improved performance with user interactions (pan and zoom).

Note: This view style can only store the drawing depth (known as graphical ‘Z’ or

‘depth’ buffering) with respect to the point overlay within the session it was

created. Subsequent use of a saved drawing with the laser survey may see an

incorrect representation of the drawing relative to the point cloud.

All other visual viewport styles will display the Z depth of the drawing correctly at

all times when overlaid with the point cloud, but graphical performance may be

slightly impaired when using these modes.
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Visual Palette4

The visual palette shown below controls which points are displayed:

Initiate/suspend AutoCAD Link4.1

This feature initiates communication between AutoCAD and AVEVA LFM Server,

the points are displayed in the relative viewpoints in AutoCAD in low density unless

a pre-selected volume has been chosen. Click the icon shown below again to

suspend the link until the function is re-selected.

Select Volume4.2

Selects a volume while increasing point density within that volume.

The box is shown dynamically in the isometric view. After the box is selected,
AVEVA LFM Server will find all points within that volume and return them to the
drawing. The following images show a volume being selected in two views:

· Front view

· Top view
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To select a volume, follow the steps below:

1. Click the Select Volume icon.

2. Click to select and drag a box in the front view.

3. Click to select and drag a box in the top view. Higher density point

clouds of the selected volume are returned from AVEVA LFM Server.

4. You can now toggle low density points for greater clarity.

Note:  Click into the window with the cursor to make active before attempting to

make a selection.

The AutoCAD status window displays selection tips for greater clarity.
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Cancel Selected Volume4.3

To cancel the selected volume, click the highlighted option below.

Zoom to point4.4

Select a point and the active view is zoomed and centred on the point selected.

Zoom to extents of points4.5

This function is comparable to the Fit View function within AutoCAD. Click the

highlighted button on the palette, then click in an AutoCAD window. The window

selected should then zoom. The new extents will match the whole dataset if no

volume is selected, otherwise it shows the extents of the selected volume. This

function should be run at least once as it is used to decide the centre of the

volume of the points displayable in AutoCAD. If this is not run, the rotation point in

AVEVA LFM Server is used as the centre of this volume.

Toggle Display of Low Density points4.6

To toggle the display of low density points:

1. Click the button shown below, and then refresh the display to switch off

the display of the low-density points data.

2. Click the button again to switch on the display of low-density points.

Toggle Display of all points4.7

To toggle the display of all points:

1. Click the button shown below, and then refresh the display to switch off

the display of all points data.

2. Click the button again to switch on the display of points.
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Toggle Solid Point Cloud4.8

Use this feature to toggle Solid Point Cloud data. For more information, please

refer to the HyperBubble and Solid Point Cloud Creation and Use Guide.

Planar Deviation Measurements4.9

The AVEVA LFM Server/AutoCAD link has the ability to colour point cloud data by

distance/depth to aid deformation visualisation and analysis. You may select one

of the following planes within the point cloud data:

· Horizontal plane (1 pick)

· Vertical plane (2 picks)

· Free plane (3 picks)

To measure a plane, follow the steps below:

1. Select the corresponding icon for the plane you wish to measure and

then pick the relevant number of points within the AutoCAD 3D window.

On the final pick, a blue grid is displayed which tracks the mouse cursor,

this gives a preview of the plane that is selected should you pick that

point.

2. For example, to measure the deviation of a wall, select the Vertical icon

and click on 2 points on the wall to be measured. An initial deviation

measurement is displayed.

3. At this point, you may roll the mouse wheel to increase or decrease the

depth of the plane. When you are happy with the deviation

measurement, click to complete the measurement.
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4. You can then save this to the AVEVA LFM Server project by going into

the AVEVA LFM Server interface and dragging the Plane Deviation

measurement from the Measurements Workspace to the Project

Measurements area within the Measurements tab.

Note:  If you want to cancel the deviation measurement, right-click or press the

Esc key.

Pick Point to Show in BubbleView4.10

Displays the scan intensity BubbleView of a picked point in the AutoCAD

environment. The BubbleView enables the designer to place themselves at any

scan location and to perform a virtual fly-through in the laser scan. Real time

zooming and panning gives the user the sensation of actually flying around the

scanned environment. Coordinate extraction and measurement functionality is

then available to the user. A position marker will be displayed in the BubbleView to

highlight the point of interest.

Note:  Because the Dataset is compiled from potentially hundreds of separate

scans, the BubbleView displayed is from the original scan of a selected point,

which may not be the most appropriate viewpoint.
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You can refine this by re-selecting the function, and picking in another area of the

point cloud.

Alternatively, other scan sites that are close by are visible in the BubbleView as 3D

scanner icons. To load the BubbleView for that scan, right-click the scan icon and

click Show BubbleView.

Cloud Selection4.11

After an aligned volume has been selected in an AutoCAD window, this feature

enables the user to further refine the volume by omitting points that are of no

interest. Select the area of interest with the left mouse button, and closing the

fence with the right mouse button. If the user closes or selects a point outside the

current viewport, this function resets.

Toggle Edge Mode4.12

This mode is ideal for visualising the edges of features, such as walls and

pavements, in laser scanned data.
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Options4.13

These options may be adjusted to suit the project. Default values are

recommended for typical applications.

Options include the following:

· Point Density Options

· Tie-in(s) Display

Point Density Options

This varies the point cloud density displayed on the screen after volume selection.

Note:  Very dense points may affect performance.

Tie-in(s) Display

Set this as appropriate for displaying tie-ins in the CAD drawing. Selecting the Line

option displays a centreline with a “flick” at each end to indicate the radius.
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Clash Palette5

The clash palette shown below controls clash functionality, pipe fitting and CAD

object and tie-in display.

Clash Detection5.1

Clash Detection is a powerful tool for the designer. It allows entire AutoCAD

design files to be clashed against the point cloud data in AVEVA LFM Server. The

result of this Clash Detection process is a detailed and structured report which lists

each interference. By clicking on each result in the list, AVEVA LFM Server shows

the specific object interfering with the point cloud data. Clash Detection functions

in both AutoCAD, MEP, CADWorx and AutoPlant environments. It is also fully

compatible with design files which contain XREFs.

AVEVA LFM Clash Evaluation Overview

When the Clash button is pressed in AutoCAD, AVEVA LFM Server receives the

entire design file from AutoCAD. Bounding boxes relating to each of the modelled

elements are sent across the link into the AVEVA LFM Server environment. These

are then analysed for collisions within the Dataset.
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The design is copied into AVEVA LFM Server, and clashes are visually highlighted

for the operator to review. Clashes can be assessed in turn and actioned, and then

removed from the Clash Display Table. Clashes can be reviewed in the 3D point

cloud, or in the BubbleView. If a collision occurs with a redundant object in the

measured point cloud, AVEVA LFM Server can remove areas of the point cloud

that have changed after the survey was completed.

Clash Detection should then be rerun and applied to existing conditions.

Points which clash with the design drawings are coloured red in the AutoCAD

display, as shown below:

AVEVA LFM Server also displays clash points in red.

The CAD objects are displayed, in addition to the object clash bounding boxes.

Clashes can be manually reviewed by looking at imported AutoCAD CAD objects

which are fully rendered.

The illustration shows the clash in AVEVA LFM Server displaying clashes between

points and AutoCAD primitives in RED.
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The operator may turn off the clashed objects for clarity by toggling the CAD

Objects button on the Visualisation menu in AVEVA LFM Server.

 

Clash shown in AVEVA LFM Server displaying clashes between points and

AutoCAD primitives in RED.

Clash Detection in AutoCAD - Workflow

This allows AutoCAD design files to be compared to the measured point clouds in

AVEVA LFM Server. There are two options under this icon in the AutoCAD clash

palette, which include:

· Clash whole Dataset

· Clash only selected volume.

Both these options can be used in conjunction with the Quick Clash function.
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To access the clash options:

1. Click and hold over the icon, then drag and release over the desired

selection in the sub-menu which is opened.

Running a Full Dataset Clash Check

This works by passing each of the modelled CAD elements across the link to the

AVEVA LFM Server environment. These are then analysed for collisions within the

Dataset. The design is copied in AVEVA LFM Server, and clashes are visually

highlighted for the operator to review. Clashes can be assessed in turn and

actioned, and then removed from the Clash Display Table. Clashes can be

reviewed in the 3D point cloud, or in the BubbleView.

If a collision occurs with a redundant object in the measured point cloud, AVEVA

LFM Server can remove areas of a point cloud that have changed after the survey

was completed. Clash Detection should then be rerun and applied to existing

conditions.

Running a Reduced Volume Clash Check

This option will only clash the AutoCAD drawing against the volume selected,

allowing smaller areas of interest to be clashed individually for added clarity.

Note:

· The volume must be selected before the clash is started.

· Reduced volume clash check performs a tentative check which is stored in

a separate database and is not saved for future examination.

· Existing clashes will not be displayed with the Reduced Volume clash

results.

Quick Clash Evaluation

Ensuring that each proposed new element of a brownfield re-design is quickly

found to be clash free against the entire laser scan data set is of critical

importance. Conversely, once a clash is located against a proposed design object,

designers need to know exactly where the clashes would be located against the

laser scan data. Swift action then needs to be taken to resolve this.
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For a rapid tentative clash check, use the AutoCAD element selection tool to

select object(s) to clash check against the point cloud, and then click the Clash

Detection icon.

Run the clash check.

When the clash check procedure is initiated, AVEVA LFM will first check to see if

any elements of the drawing are selected.

If AVEVA LFM detects any selected items, the user will be prompted to accept the

clash check relates to the selection only - or all the drawing.

Note:

· Quick Clash check performs a tentative check which is stored in a

separate database and is not saved for future examination.

· Existing clashes will not be displayed with the Quick Clash results.

· Object clash, or volumetric clash analysis is possible with this feature.

· Results of quick clashes are not added to the clash text file or database.

Clearing the Clash List

To clear the clash list in the AVEVA LFM Server Clash Manager:

1. Expand the clashing sub-menu by clicking and holding the left mouse

button.

2. Move over the Clear Clash List button and release the left mouse

button. A confirmation dialog appears asking you if you wish to proceed.

3. Click Yes to clear the clash manager within AVEVA LFM Server.
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Options - Clash Clearance5.2

The default clash clearance can be adjusted to suit the project needs as shown

below:

 

Reviewing a clash report5.3

The clash report indicates the drawings that have been checked against the point

cloud, and if the drawing is clash free. The parent group is displayed as a pass or

a fail in the listing, and is highlighted as a green tick or a red cross. The group

checked could be a drawing or a layer.

Clash shown adjacent in AVEVA LFM Server 3D. All clashes between points and

CAD primitives are displayed in RED.
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The following image displays the Clash Manager after a clash check, the group

checked is displaying a fail (red cross). The user has expanded the branch to look

for individual objects causing concern. Each item can be interrogated and

manipulated as required.

For detailed information about interpreting and customising these reports for

project work, refer to the AVEVA LFM Server Home Guide - Show Clash Manager.

Show Solid Objects5.4

Any 3D solid object in an active AutoCAD model will be displayed in AVEVA LFM

Server. This enables visual clash detection or point cloud versus model reviews in

the AVEVA LFM Server environment. The objects can also be viewed in the

BubbleView for greater clarity.

Clip function5.5

If the CAD drawing is large it can be difficult to review the displayed points around

a relevant area. The working zone can be displayed in isolation to aid clarity,

based on the dimensions of the current selected volume on the screen.
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The following image shows a sample volume with the full CAD drawing displayed.

Selecting Clip on the Visualisation menu will then mask any part of the drawing

outside the volume of interest. This can be reset by clicking the Clip button again,

which shows all the drawings in addition to the displayed points. Toggle CAD

Objects to turn off the CAD objects.

 

Note:  Clip display works in Perspective and Orthographic views.
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This will also display the AutoCAD drawing objects inside the BubbleView window.

This function should be applied after a suitable BubbleView is selected. This is

particularly useful for gauging free space in congested areas, and should

complement 3D point cloud evaluation. This may take a small amount of time to

process, depending on how many objects are passed to the BubbleView.

 

After the appropriate BubbleView has been loaded, show the objects in the

BubbleView by clicking the Objects button as shown below:

Selecting All Objects shows all objects. Selecting Dynamic Objects shows an

object when the mouse is hovered over it. Selecting None does not display any

objects.
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Toggle Solid Point Cloud Clipping5.6

To clip a Solid Point Cloud image in the AutoCAD interface:

1. Click Volumes on the tool palette, and on the Volume Settings dialog

enable Clip. This overrides the clipping done on the AVEVA LFM Server

interface.

2. To view only the clipped portion of the image, click Toggle Solid Point

Cloud Clipping.

Find Objects5.7

This will centre the last CAD object passed to AVEVA LFM Server on the screen.

This enables rapid navigation in the AVEVA LFM Server environment based upon

the CAD design.

Fit Pipe5.8

Uses a Segmentation algorithm to fit a pipe-to-point data in AutoCAD.
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Select any point associated with a pipe point cloud. The result is a best fit 3D solid
model.

Import Tie-ins5.9

This is used to import plant tie-in points from AVEVA LFM Server.

The user will be prompted with the tie point description when the cursor is placed

near the base of the tie point. This functionality is linked to the relevant AVEVA

LFM Server connection application [for example, lfmserver2013.arx].
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If you want to view these descriptions when not connected to AVEVA LFM Server,

you must load the application TieIn20XX.dbx which is stored in the same directory

as the Server AutoCAD arx files. [C:\Program Files\LFM Software\LFM\arx].

The following image displays the tie point description on the interface:

Demolish points about objects5.10

To demolish points about objects:

1. Select an element in the AutoCAD display, then select the icon shown

below to create a volume in AVEVA LFM Server and to allow precise

demolition based on the object volume.

The dialogue window shown below gives the user the option to confirm

that the selected elements represent the desired volume.

 

2. Click Yes to pass the selection over to AVEVA LFM Server.
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3. Within AVEVA LFM Server, click the Demolition Objects button on the

Visualisation menu bar to display the demolition objects. The selected

objects are displayed within a translucent overlay which represents the

selected demolition clearance. This may be altered through the main

AVEVA LFM Server options window. Points which are within this volume

may then be highlighted or hidden prior to demolition.

 

Add to Volume List

To add to the volume list:

1. After the CAD objects have been passed across for demolition, select

the icon shown below to add to the Volume Manager. All Volume

Manager functionalities may then be applied to these volumes.

2. Type in a category name to receive the volume.
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3. The volume is displayed in the Volumes Manager, and can then be

demolished or used as described in the AVEVA LFM Server Home

Guide.

 

Highlight Tentative Demolition

To highlight tentative demolition:

1. Select a volume around the points to be highlighted.

2. Right-click on the category within the Volume Manager and select

Identify Volumes to highlight the points within the category in pink.

Tentative Demolition

To apply tentative demolition:

1. Select a volume around the points to be highlighted.

2. Right-click on the category within the Volume Manager and select

Tentative Demolition to give an accurate preview of the post-

demolition state.

3. Click the Demolition Objects button to toggle the object bounding

boxes on and off for a clear view of the point cloud data.
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Useful Commands6

This section covers some of the commands that a user can perform in the

AutoCAD interface.

Snapping to Scanned Data Points6.1

Snapping to 3D points is useful for constructing primitives in AutoCAD.

To snap to scanned data points:

1. First activate the appropriate AutoCAD window by clicking in it.

Snapping to a point is achieved by first pressing and holding down the

Ctrl key and simultaneously moving the mouse over the desired 3D

point. When the point is within snapping range, a small blue circle

appears.

2. The snapping process is completed by then clicking the left mouse

button. As long as the Ctrl key is held down, snapping will continue and

in this way, multiple points can be snapped to.

All AutoCAD drawing commands may be used with scanned data points by using

the snap-to-point facility.

Plotting from AutoCAD6.2

This feature enables the user to print out plots that have the scanned data and the

models correctly merged. This can be especially useful for discussions away from

the normal computing environment or for displaying it to the clients.

Plotting takes place from the active window in AutoCAD. For this reason, it is

recommended that only one window is displayed and that it covers the full screen.

After the correct view is established, it is a matter of typing the plot in the

command window. Execution of this command may take around 10 minutes to

complete. After it is done, the view can be plotted as normal.
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After this view is finished with, type LFMremoveplot to erase the data. More plots

can then be created as required.

Create Extents6.3

The createext command creates a bounding box around the extents of the

scanned data points. This command is normally needed when an AutoCAD file,

without any extents defined, is being connected to a Dataset. This ensures that the

zoom extents command functions correctly and that the clipping planes are set

correctly in AutoCAD.
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